
 Silver Series EM OIT Sample Project 

Using the Sample Project 
These instructions assume you have obtained an archive (*.zip) containing a sample 
project and opened these instructions from within that archive. 

Installing the Sample Project 
To install and inspect the sample project: 

1. Copy the project file (the file with the “.emtp” extension) from the archive to the 
project directory for EZwarePlus. Typically “C:\Watlow\EZPlus\project”. 

2. Copy the Excel tag database files (files with *.xls extension from the archive to 
the library directory for EZwarePlus. Typically “C:\Watlow\EZPlus\library”. 

3. If desired, copy the sample application description (the file with the .pdf 
extension) to your desktop or other suitable location. 

4. Launch EZwarePlus (Start/All Programs/Watlow/EZwarePlus/EZwarePlus) 
5. Choose Open an Existing Project and click OK. 
6. Locate and select the sample project and click Open. 

How to use the Sample Project 
To see how things were done, read through the section, Things to Observe while 
reviewing the corresponding windows with the project open in EZwarePlus. 

For an EZ-ZONE® RM controller communicating via Modbus® RTU, you can compile 
and download the project to your Silver Series EM OIT to try it out. 

To modify the project for use with a different EZ-ZONE® controller, see the section, 
Importing a Tag Database to use another Controller. 

To modify the project to communicate via Modbus® TCP, see the section, Changing the 
Communications Driver to Modbus® TCP. 

For more about working with projects see Addendum to EZwarePlus Programming 
manual (p/n 0600-0102-0000) available on www.watlow.com. 
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Things to Observe 
Note the following features in the sample project. 

Common Window (Window 4): 
• The mouse cursor (pointer) is disabled with a Set Bit object that sets the System 

Tag LB-9018 to On when the window opens. 

• The navigation buttons (Function Keys) that appear on every full screen window 
are actually only on the common window. 

• The “Set Up Users” Function Key is set to be invisible on its Security Tab except to 
users that have access to Class C objects. 

Initial Window (Window 10): 
• The Option List for the Control Mode takes up more space in the screen designer 

than it occupies when the window is running on the OIT because it is sized 
according to how it appears when the user has clicked it to make a selection. This 
limits where it is placed, i.e. you cannot place it where it would open off the bottom 
of the screen. However, the space can be used for objects that do not need to be 
visible when the Option list is closed. Note how the top of the Bar Graph is in the 
space the Option List covers when it is open. 

Recipes (Window 11): 
• This is a pop-up window that appears when the Select Recipe Function Key on the 

Recipe Manager window is pressed. 

• The five ASCII Display objects display the names users have assigned to recipes. 
These names are stored in memory locations RW-10, RW-30, RW-50… to …RW-
490, but only the names of 5 recipes are shown at a time. Which recipes names 
are shown depends on the setting of address index 1. 

• The up and down arrow keys are Set Word objects that increment and decrement 
the system word LW-9201, address index 1, from 0 to 400 in steps of 100. This is 
used to scroll through the list of recipe names five recipes at a time. When address 
index 1 is set to 0 the five ASCII Display objects show the recipe names stored at 
RW-10, RW-30, RW-50, RW-70 and RW-90. When the user presses the down 
arrow which increments address index 1 by 100 the list shows the recipe names 
stored at RW-110, RW-130, RW-150, RW-170 and RW-190. Pressing the down 
arrow again shows the next five recipe names in the list. 

• The up and down arrow keys are prevented by limits on their General tabs from 
setting the value of address index 1 less than 0 or greater than 400. 

• The up and down arrow keys also set a bit (LB-550). When that bit is set, the PLC 
Control object runs a macro called Move Slider that sets LW-1001. This word 
determines the position of the Animation Object that appears to be a scroll bar and 
indicates where you are in the list of recipe names. See the PLC Control object by 
opening it from the Object menu and the Macros from the Tools menu. 

• Each of the five Edit buttons (Set Bit objects) runs a corresponding macro that sets 
the address 0 index such that the corresponding recipe is selected. 
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Trend (Window 12): 
• The vertical scale is not part of the Trend Display object. Instead it is a Scale 

Object and six Text Objects that have been placed next to the trend. 

• On the Trend Object’s General tab you see that the trend displays data from the 
Data Sampling Object index “0.Loop 1”. You can see the Data Sampling Object by 
opening it from the Objects menu. 

• If you inspect the Data Sampling object, you will see that it is reading four local 
words starting as LW-200, an address internal to the OIT. This is because a trend 
and a data log can include data from only one Data Sampling object and a Data 
Sampling object can contain only contiguous data. In order to graph set point and 
process variable on the same graph, Data Transfer (Time-Based) objects are used 
to copy the data from the controller to contiguous memory locations in the OIT. 
Four words in memory are used because the set point and process variable are 
floating point numbers and therefore require 32-bits of memory each which 
requires two of the OIT’s local words each to store. This method can just as easily 
be used to create a log or graph of data from multiple controllers. 

• On the Trend Object’s Trend tab, the scale for each of the two channel’s (0 and 1) 
is set to 0 to 250. It is also possible to have a user set scale by selecting the 
Dynamic limits option. 

Recipe Manager (Window 13): 
• The recipe consists of the five controller parameters plus the user-set recipe name. 

• The recipes are stored in recipe word (RW) memory which is saved to non-volatile 
(flash) memory periodically by the OIT (every 5 minutes). So it is important to wait 
for this to happen after editing a recipe and before turning off power to the OIT if 
you want the recipes to be stored in the recipe memory. It may be convenient to 
use a USB flash drive to store recipes instead since recipe changes will be saved 
immediately in that case.  

• The controller’s actual settings are displayed for reference only. It is not necessary 
to have them on the screen in order for the recipe functions to work. 

• The controller settings are copied from the controller to recipe memory by the five 
Data Transfer (Trigger-Based) objects that also serve as labels next to the Numeric 
Display objects that show the actual controller values. The trigger for the data 
transfers is a bit in the OIT (LB-500) that is momentarily set when the user clicks 
the Save as Selected Recipe button, a Set Bit object. 

• Similarly there are five Data Transfer (Trigger-Based) objects that copy values from 
the selected recipe to the controller when the Load Recipe into Controller  button 
momentarily sets their trigger (LB-501). 

• This example allows for 25 recipes stored in RW memory in the OIT. Recipe 1 is 
stored in addresses 0 to 19, recipe 2 in addresses 20 to 39 and so on. 

• Which recipe memory locations are saved to or loaded is determined by the setting 
of address index 0 which is stored in system tag LW-9200. Note that the five Data 
Transfer (Trigger-Based) objects and the five Numeric Display objects associated 
with the Selected Recipe Settings each has its Index Register option set and Index 
0 selected on the General tab. That means the value stored in the address index is 
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added to the address entered for the object. So the recipe’s set point will be stored 
at address RW-0 when Index 0 is set to zero, but it will be stored at address RW-20 
when the value in Index 0 is 20. 

• The Previous Recipe and Next Recipe buttons are Set Word objects that increment 
the recipe memory index (Index 0) up and down by 20 so that values can be stored 
in any of the recipes. These buttons are limited to setting the index to multiples of 
20 from 0 to 480 which means there are 25 sets of address available for recipes 
and therefore 25 recipes. 

• The Select Recipe Function Key pops-up the Recipes window which can also be 
used to select a recipe. 

Test Passwords (Window 14): 
• The three Numeric Input objects in the middle of the screen are examples of 

different levels of protection as indicated by the text next to each. See the settings 
on the Security tab for each to see how the objects are configured to behave. 

• From the Edit menu select System Parameters and look at the Security tab to see 
how the three users were enabled and assigned default passwords and permission 
to access the object classes (A, B and C). 

Log In (Window 15): 
• This window pops-up when you push the Log In button. The user names and 

passwords that are built into the project are displayed as text on the screen, just to 
make the demo easier to use. You would not normally display this information in 
the interface. 

• The password security feature uses local word memory (in this case LW-1000 
through LW-1019). Buttons or other features in the project write integers 
representing commands to the first word (LW-1000) such as “1” to log in and 3 to 
log out. See the help topic in EZwarePlus, “How Do I Use Enhanced Security?” for 
details about the password security feature. 

• An ASCII Input is provided for the user to enter up to 16 characters (8 words) for 
the user name under which to log in. This is set in LW-1004 through LW-1011. 

• A second ASCII Input is provided for the user to enter up to 16 characters (8 
words) for the password which is set in LW-1012 to LW-1019. To make the demo 
easier to use, the “mask” option is not set for this object, but you can set it on the 
ASCII Input’s General Tab. 

• A Numeric Input object with the mask option set on its Numeric Format tab is used 
to allow users to input the password corresponding to the selected user into the 
Password System tag (LW-9220). 

• A Word Lamp decodes the error code from LW-1002 which indicates successful or 
failed attempts to log in, for example “Password Error” if the user enters the wrong 
password. 
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User Access Maintenance (Window 16): 
• This window pops-up when you push the Set Up Users button. Note this button is 

on the Common window, but it is only visible when the user MIKE or another user 
with access to Class C objects is logged in. 

• The Add User group has ASCII Inputs to allow entry of a new user name and 
password. 

• The Add User group also has six Toggle Switches each of which sets a bit in LW-
1003 to set the new user’s access to classes A to F (bits 0 to 5). Note classes A 
through L may be used to protect screen objects, but this sample project uses 
fewer. 

• The Set Word button labeled “Add User” sets the password command word (LW-
1000) to 5 to add a user with the name, password and access set in the Add User 
group. 

• The Change or Delete User group has an Option List that is populated with the list 
of users, by setting is Source of Data property on the Option List tab to “User 
account”. And monitors LW-1002, the Selected Item Index for the password 
feature. Use this to select the user to modify or delete. 

• In the Change or Delete User group select a user, enter a new password and touch 
Change Password to set the command (LW-1000) to 12 to change the password 
for the selected user. 

• Touch Show Access to display the access settings for the selected user in the 
Change or Delete User group by setting the command (LW-1000) to 14. 

• In the Change or Delete User group select a user, set the desired permissions by 
with the A to F toggle switches and touch Change Access to set the command 
(LW-1000) to 12 to change the password for the selected user. 

• Note the local word address for the security feature is user set per project, it is not 
necessary to use the specific addresses used in this example. The Control Address 
for security in the project is set as the Control Address on the Security tab in the 
System Parameter Settings dialog. All other addresses (for user name, password 
etc.) are relative to that address. See the help topic in EZwarePlus, “How Do I Use 
Enhanced Security?” for details about the password security feature. 
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Controller Configuration 
This sample project is set up to communicate with an EZ-ZONE® RM controller via 
Modbus® RTU configured as indicated below. You can adjust the settings in your 
controller or the project as necessary. 

Controller EZ-ZONE RM 

Model RMC1_ _ _ _ _ _ _ _1_ _ or equivalent 

Protocol Modbus RTU 

Address 1 Word Order Low High 

Baud 38.4 C-F F 

Parity None Map* 1 
*If present. 

Importing a Tag Database to use Another Controller 
This sample project is set up to communicate with an EZ-ZONE® RM controller. To use 
it with another controller, import one of the tag libraries from the sample project archive 
into the project with EZwarePlus. 

To import a tag file: 
1. In EZwarePlus, from the Library menu, choose Tag… 
2. Click Import EXCEL… 
3. Select and open the file for the desired controller and address map. 
4. When prompted to delete existing tags, click Yes. 
5. Click OK. 
6. Click Exit. 

Silver Series EM Configuration 
This sample project is configured to communicate with a controller as indicated below. 
You can see these settings in the System Parameters Settings dialog. 
 

OIT TS00-0043-EM00, TS00-0070-EM00 or 
TS00-0100-EM00 

PLC type Modbus RTU Master 

PLC Interface RS-485 2W 

COM COM 1 (38400,N,8,1) 

PLC default station no. 1 
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Changing the Communications Driver to use Modbus® TCP 
The sample project is set up to communicate by Modbus® RTU via RS-485. To use 
Modbus® TCP, change the driver in the project in EZwarePlus. 

To change the communications driver: 
1. In EZwarePlus, from the Edit menu, choose System Parameters… 
2. In the Device List, select the “Local PLC” item by clicking it. 
3. Click Settings… 
4. Click “Modbus RTU Master”. 
5. From the driver list, choose Modbus TCP/IP Master. 
6. Click Settings… 
7. Enter the IP address of the EZ-ZONE® controller of gateway. 
8. Click OK to close the IP Address Settings dialog. 
9. Click OK to close the dialog with the driver list. 
10. Click OK to close the Device Properties dialog. 
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